
Microsoft Outlook 97 Keyboard Shortcuts
ALT Close the visible menu and submenu at the same time; works with menu commands. 

ALT+0 (ZERO) View 10 days; works when using general keys for moving around in the day/week/month/view. 

ALT+1 View 1 day; works when using general keys for moving around in the day/week/month/view. 

CTRL+Shift+Q Keys to create a new meeting request or open an existing meeting request. 

CTRL+Shift+R Reply All to an E-Mail. 

CTRL+Shift+RIGHT ARROW Select or unselect one word to the right of the cursor. 

CTRL+Shift+T Reduce the size of a hanging indent formatted on onto a selected block of text. 

CTRL+Shift+TAB Go to the previous tab when working in a tabbed dialog box. 

CTRL+Shift+TAB or CTRL+PAGE UP Go to the previous tab when working in a tabbed dialog box. 

CTRL+Shift+U Create a new Task request or open an existing Task report in Outlook. 

CTRL+Shift+UP ARROW Extend the selection to the previous card, regardless of the starting point. 

CTRL+Shift+V Paste an item from one place to another. 

ALT+B Display the previous tip; use with Office Assistant. 

ALT+C Close Print Preview; use within menu commands. 

ALT+D Decline when responding to an E-Mail schedule request; use within menu commands. 

ALT+DOWN ARROW Go to the same day in the next week; works with general keys for moving around in day/week/month

view. 

ALT+DOWN ARROW Move selected item to the same day in the next week; works with general keys for moving around in

day/week/month view. 

ALT+DOWN ARROW Display more Help topics; works when using Office Assistant. 

ALT+DOWN ARROW Go to the same day in the next week; works with general keys for moving around in day/week/month

view. 

ALT+DOWN ARROW Open a selected drop-down menu; works within a dialog box. 

ALT+END Go to the last day of the current week; use within the Date Navigator. 

ALT+EQUAL SIGN Switch to month view when using general keys for moving around in day/week/month view. 

ALT+F4 Close a selected window while working in Outlook; if you have only one open window, close Outlook. 

ALT+F6; repeat until the balloon is

active

Activate Office Assistant while working in a document. 

ALT+HOME Go to the first day of the current week when using general keys for moving around in day/week/month

view. 

ALT+HYPHEN SIGN Switch to week view when using general keys for moving around in day/week/month view. 

ALT+I to select the Folder List; arrow

keys to sel

Select the folder list in Save As dialog box (in the File menu); use arrow keys to select a folder. 

ALT+K Display the Task menu while working in Outlook. 

ALT+key for number of days View anywhere from 2 through 9 days at a time; works when using general keys for moving around in

day/week/month view. 

ALT+LEFT ARROW Move a selected item to the previous day when multiple days appear; use when working with general

keys for moving around in day/week/month view. 

ALT+letter key, where the key is the

underlined le

Select a menu, or select or clear the check box by the letter underlined in the menu name in a dialog

box. 

ALT+N Display the next tip when working with Office Assistant. 

ALT+number (where hitting key for 1

selects the le

Select a Help topic while using Office Assistant. 

ALT+number (where hitting key for 1

selects the le

Select an option in the Save As dialog box (in the File menu). 

ALT+O Display the Format menu. 

ALT+P Print from Print Preview window. 

ALT+PAGE DOWN Go to the last day of the month when using general keys for moving around in day/week/month view. 

ALT+PAGE UP Go to the first day of the month when using general keys to move around in day/week/month view. 

ALT+PRTSCR Copy the active window to the Windows Clipboard. 
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ALT+RIGHT ARROW Move a selected item from one to the next day when multiple days appear; use when working with

general keys for moving around in day/week/month view. 

ALT+S Save, close and Send when working with E-Mail. 

ALT+S, ALT+U Print Preview current page. 

ALT+Shift+TAB Move from active application window to previously active application window. 

ALT+SPACE Display the active window's title bar menu. 

ALT+SPACEBAR Open the menu of the leftmost icon on the main toolbar bar of the active window; this menu typically

contains the following commands: Restore, Move, Size, Minimize, Maximize and Close. 

ALT+TAB Move from active application window to the previously used application window; to select an

application from a list of the open applications, hold ALT down and press TAB more than once to move

through the list. 

ALT+letter key, where the key is the

underlined le

Select a menu, or select or clear the check box by the letter underlined in the menu name. 

ALT+UP ARROW Go to the same day in the previous week when using general keys for moving around in

day/week/month view. 

ALT+UP ARROW Move selected item to the same day in the previous week when using general keys for moving around

in day/week/month view. 

ALT+UP ARROW Display previously viewed Help topics while using Office Assistant. 

ALT+UP ARROW Go to the same day in the previous week when using general keys for moving around in

day/week/month view. 

ALT+UP ARROW or ESC (when a drop-

down list box is 

Close a drop-down list box while working in a dialog box. 

ALT+UP, DOWN, LEFT, or RIGHT

ARROW

Move a selected appointment up, down, left, or right when using general keys for moving around in

day/week/month view. 

ALT+Z Zoom in on an area of detail while working in Print Preview. 

CTRL+Shift+ Go to previous item (with an item open) in Outlook. 

CTRL+Shift+> Go to next item (with an item open) in Outlook. 

CTRL+Shift+A Create a new Appointment or to open a selected Appointment. 

CTRL+Shift+B Open the Address Book when sending an E-Mail. 

CTRL+Shift+C Create a new contact or open a selected contact. 

CTRL+Shift+D Dial. 

CTRL+Shift+DOWN ARROW Extend a selection of one card to the next card, regardless of the starting point. 

CTRL+Shift+E Create a new folder or open a selected folder. 

CTRL+Shift+F Display the Find dialog box when working in Outlook. 

CTRL+Shift+I Go to Inbox. 

CTRL+Shift+J Create a new journal entry or open an existing one. 

CTRL+Shift+K Create a new Task or open an existing one when working in Outlook. 

CTRL+Shift+L Add bullets to a selection when working in Outlook. 

CTRL+Shift+LEFT ARROW Select or unselect one word to the left of the cursor. 

CTRL+Shift+M Create a new Message or open an existing one when working in Outlook. 

CTRL+Shift+N Keys to create a new Note or open and existing Note when working in Outlook. 

CTRL+Shift+O Go to Outbox. 

CTRL+Shift+P Go to Find People command. 

CTRL+Shift+Y Copy an item. 

CTRL+Shift+Z or CTRL+SPACEBAR Clear formatting ona selected area. 

CTRL+SPACEBAR Select or unselect the active card. 

CTRL+SPACEBAR Select or unselect the active item. 

CTRL+T Increase indent on a selected block of text. 

CTRL+TAB Move to the next tab on a tabbed dialog box. 

CTRL+TAB or CTRL+PAGE DOWN Move to the next tab on a tabbed dialog box. 
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CTRL+TAB or CTRL+Shift+TAB. Select the next or previous toolbar. 

CTRL+TAB or F6 Move between Calendar, TaskPad, and the Folder List when moving around in day/week/month view. 

CTRL+UP ARROW Move the insertion point to the previous card. 

CTRL+UP ARROW or CTRL+DOWN

ARROW

Go to the next or previous item without extending the selection. 

CTRL+UP or HOME Move to the beginning of a selected item when working in Print Preview. 

CTRL+V or Shift+INSERT Paste a copied item(s) from the Clipboard into a selected location (You also can choose Paste from

the Edit menu.). 

CTRL+X or Shift+DELETE Copy and remove the selected item(s) from their original location to the Clipboard. (You also can

choose the Cut command from the Edit menu.). 

CTRL+Y Display Go to Folder dialog box in order to find and open a specific folder. 

CTRL+Z or ALT+BACKSPACE Undo the last action; note: some actions, like Shutdown, cannot be undone (You also can choose

Undo from the Edit menu.). 

DOWN ARROW Select the next card. 

DOWN ARROW Go to the next line in a multiline field in Outlook. 

DOWN ARROW Go to the item below when working in a Table. 

DOWN ARROW Select the next group when a group in a Table is selected. 

DOWN ARROW Select the next group in a Timeline. 

DOWN ARROW Select the next block of time when working in day/week/month view. 

DOWN ARROW or UP ARROW (with the

menu or submenu v

Select the next or previous command on the menu or submenu. 

END Go to the end of the entry when working in a text box. 

END Select the last card in a list. 

END Go to the end of a line. 

END Select the time that ends your work day when working in day/week/month view. 

END Go to the last day of the week when working in day/week/month view. 

END Go to the last item in a Table. 

END Select the last group in a Table is selected. 

END Select the last item on the timeline (if items are not grouped) or the last item in the group when working

in timeline. 

END Select the last group on the timeline when a group on the timeline is selected. 

ENTER Select an item. 

ENTER Perform the action assigned to a selected button in a dialog box. 

ENTER Move to the next field, or to add a line to a multiline field. 

ENTER Open a selected item in a table. 

ENTER Open selected items in a timeline. 

ENTER Perform the action assigned to a selected button on a toolbar. 

ENTER Open a selected menu on a toolbar. 

ENTER Enter text in a selected text box. 

ENTER or LEFT ARROW Collapse a selected group in a table. 

ENTER or LEFT ARROW Collapse a selected group in a timeline. 

ENTER or RIGHT ARROW Expand a selected group in a table. 

ENTER or RIGHT ARROW Expand a selected group in a timeline. 

ESC Cancel the current operation. 

ESC Close the visible menu; or, with a submenu visible, close the submenu only. 

ESC Cancel a command and close the dialog box. 

ESC Close an Office Assistant message or tip. 

F1 Display Help or the Office Assistant. 

F10 Activate, or select, the main toolbar beginning with the first toolbar option on the left, usually File; after

the first option is activated you can navigate through toolbar and menu options using the appropriate
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ARROW keys; press F10 or ALT again 

F10. Activate, or select, the main toolbar beginning with the first toolbar option on the left, usually File; after

the first option is activated you can navigate through toolbar and menu options using the appropriate

ARROW keys; press F10 or ALT again 

F12 Display Save As dialog box (file menu). 

F2 Activate editing in a field (except icon view field). 

F2 Move to a field in the active card. 

F2 or click the field Display the insertion point in the active field in order to edit text. 

F3, CTRL+Shift+F Open the Find dialog box. 

F4 Open the Find dialog box in Outlook. 

F5 Refresh the current window (You also can choose Refresh from the View menu.). 

F5 Update the files visible in the Open or Save As dialog box (File menu). 

F6 Cycle through all the panes in the active window. 

F6 or CTRL+Shift+TAB Move between the Folder List and the information viewer to the right. 

F6/Shift+F6 Move to the next or previous window. 

F7 Display Spelling and Grammar dialog box (Tools Menu). 

HOME Move to the beginning of the current entry. 

HOME Select the first card in the list. 

HOME Move to the beginning of the current line. 

HOME In day/week/month view, select the time that begins your work day. 

HOME In day/week/month view, go to the first day of the week. 

HOME Go to the first item. 

HOME Select the first group on a timeline with grouped items. 

HOME Select the first item on the timeline (if items are not grouped) or the first item in the group. 

HOME or END Select the first or last command on the menu or submenu. 

LEFT ARROW Select the closest card in the previous column. 

LEFT ARROW Move to the previous character in a field. 

LEFT ARROW Go to the previous day, when working in day/week/month/view. 

LEFT ARROW Select the previous item on the timeline. 

LEFT ARROW Move back in increments of time that are the same as those shown on the time scale, when a unit of

time is selected on the time scale. 

LEFT ARROW or RIGHT ARROW With a menu open, select the menu to the left or right of the original, or, with a submenu visible, switch

between the main menu and the submenu. 

LEFT ARROW or RIGHT ARROW Move one character to the left or right in a text box. 

Letter key, where the letter is the same

as the fi

Choose a selected menu, drop-down list, or dialog box option by typing the first letter in the option

name. 

PAGE DOWN Select the first card on the next page. 

PAGE DOWN Move to the end of a multiline field. 

PAGE DOWN Select the block of time at the bottom of the screen when working in day/week/month view. 

PAGE DOWN Go to the item at the bottom of the screen, and then display another page of items when working in a

Table. 

PAGE DOWN in a Timeline, display the items one screen below the items on the current screen. 

PAGE DOWN or DOWN ARROW In day/week/month view, go to the same day of the week in the next week (or 5 weeks ahead if

viewing by month). 

PAGE UP Select the first card on the current page. 

PAGE UP Move to the beginning of a multiline field. 

PAGE UP In day/week/month view, select the block of time at the top of the screen. 

PAGE UP In a Table, go to the item at the top of the screen. 

PAGE UP In a Timeline, display the items one screen above the items on current screen. 

PAGE UP or UP ARROW In day/week/month view, go to the same day of the week in the previous week (or 5 weeks previous if
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viewing by month). 

PLUS or MINUS SIGN on the numeric

keypad

Xxpand/collapse a group (with a group selected). 

PRTSCR Copy an image of the screen to the Windows Clipboard. 

RIGHT ARROW Move to the next character in a field. 

RIGHT ARROW In day/week/month view, go to the next day. 

RIGHT ARROW When a group in a table is selected, select the first item on screen in an expanded group or the first

item off screen to the right. 

RIGHT ARROW in a Timeline, select the next item. 

RIGHT ARROW When a unit of time on the time scale for days is selected, move forward in increments of time that are

the same as those shown on the time scale. 

RIGHT ARROW Select the closest card in the next column. 

Shift+ALT+ESC Move to the next open window. 

Shift+CTRL+F6 Move to the next/previous Outlook window. 

Shift+CTRL+TAB Move between toolbars. 

Shift+DOWN ARROW Extend the selection to the next card or to unselect cards before the starting point. 

Shift+END Select from the insertion point to the end of the text box entry. 

Shift+END Extend the selection to the last card in the list. 

Shift+ENTER Move to the previous field without leaving the active card. 

Shift+F1 Display ScreenTip for the active item. 

Shift+F10 Display a shortcut menu that shows a list of commands relevant to the selected object. 

Shift+F3 Change the case of selected letters. 

Shift+F4 Find the previous occurrence of the text specified in the Find or Replace dialog box when the dialog

box is closed. 

Shift+HOME Select from the insertion point in the text box to the beginning of the text box entry. 

Shift+HOME Extend the selection to the first card in a list. 

Shift+LEFT ARROW Select or unselect one character to the left of the cursor's position. 

Shift+LEFT ARROW or Shift+RIGHT

ARROW

Select several adjacent items on a timeline. 

Shift+left mouse button Specify a Web browser. 

Shift+LEFT, RIGHT, UP, or DOWN

ARROW; or Shift+HOM

Change the duration of the selected block of time when working in day/week/month view. 

Shift+PAGE DOWN Extend the selection to the last card on the last page. 

Shift+PAGE UP Extend the selection to the first card on the previous page. 

Shift+RIGHT ARROW Select or unselect by one character to the right of the cursor's current position. 

Shift+TAB Move to the previous option or option group in a dialog box. 

Shift+TAB Move to the previous field and, from the first field of a card, move to the last field in the previous card. 

Shift+TAB Select the previous appointment when working in the day/week/month view. 

Shift+TAB When a unit of time on the time scale for days is selected, select the upper time scale (when the lower

time scale is selected). 

Shift+UP ARROW Extend the selection to the previous card and unselect cards after the starting point. 

Shift+UP ARROW or DOWN ARROW Extend or reduce the selected time when working in the day/week/month view. 

Shift+UP ARROW or Shift+DOWN

ARROW

Extend or reduce the selected items by one item when working in a table. 

SPACEBAR Perform the action assigned to the active button, or select or clear the active check box in the dialog

box. 

SPACEBAR (when the menu bar is

active)

when the menu bar is active, display the program Control menu. 

TAB Move to the next option or option group. 

TAB Select a field when moving between fields on a card. 

TAB Move to the next field and, from the last field of a card, move to the first field in the next card. 
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TAB Select the next appointment when working in day/week/month view. 

TAB Move from item to item when working in day/week/month view. 

TAB Select the lower time scale (when the upper time scale is selected) and a unit of time on the time scale

for days in selected. 

TAB Select the first item on screen or the first group on screen if items are grouped (when the lower time

scale is selected) and a unit of time on the time scale for days in selected. 

TAB or Shift+TAB (when a toolbar is

active).

When a toolbar is active, select the next or previous button or menu on the toolbar. 

LETTER KEY, where you type one or

more letters of 

Select a specific card in the list. 

UP ARROW Select the previous card. 

UP ARROW Move to the previous line in a multiline field. 

UP ARROW Go to the item above current position when working in a table. 

UP ARROW When a group in a table is selected, select the previous group. 

UP ARROW When a group in a timeline is selected, select the previous group. 

UP ARROW Select the previous block of time when working in day/week/month view. 

UP ARROW, DOWN ARROW, PAGE UP,

or PAGE DOWN

Scroll through pages when working in Print Preview. 

UP, DOWN, LEFT, OR RIGHT ARROW Move from item to item when working in day/week/month view. 

ALT+Shift+UP ARROW or DOWN

ARROW, with the cursor 

Change an appointment start or end time when working in day/week/month view. 

ARROW KEY Move between options in a selected drop-down menu or dialog box or between some options in a

group of options. 

ARROW KEY Move between options in a selected drop-down menu or dialog box or between some options in a

group of options; add ENTER to select an option. 

CRTL+U Underline the following text or to underline a selected section of text. 

CTRL+ Shift+S Post selected item to a designated folder. 

CTRL+[ Decrease the font size of selected text by 1 point. 

CTRL+] Increase the font size of selected text by 1 point when working within a document. 

CTRL+A Select all items in an active folder when working in Windows Explorer-Tree View. 

CTRL+A Select All in a designated area or document. 

CTRL+ALT+DELETE Display the Close Program dialog box in order to close active programs, or to shut down the entire

computer system. 

CTRL+B Apply or remove Bold formatting to selected text or document. 

CTRL+C or CTRL+INSERT Copy selected text or items to Windows Clipboard. 

CTRL+D Delete the current selection or item in Outlook. 

CTRL+DOWN ARROW Move to the next card while working in Outlook. 

CTRL+DOWN or END Move to the end of an item while in Print Preview. 

CTRL+E Center the paragraph in which the cursor is positioned within an Outlook document. 

CTRL+END Move to the last card in the list while working in Outlook. 

CTRL+END Display (without selecting) the last item on the timeline (if items are not grouped) or the last item in a

group while working in Outlook. 

CTRL+ENTER (except WordMail) Send/post/invite all when working in Outlook. 

CTRL+ESC Display Windows Start menu. 

CTRL+F Forward a selected E-Mail itemwhile working in Outlook. 

CTRL+F2 Display the Print Preview dialog box while working in Outlook. 

CTRL+HOME Go to the first card in a list when working in Outlook. 

CTRL+HOME Display (without selecting) the first item on the timeline (if items are not grouped) or the first item in the

group when working in Timeline mode of Outlook. 

CTRL+HOME or CTRL+END Move every item in a selection to the top or bottom of a specified list. 

CTRL+I Apply or remove italic formatting to selected characters. 
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CTRL+K (except in WordMail); ALT+K

(WordMail only)

Check names. 

CTRL+K (WordMail only) Insert a hyperlink from a document to a specified Web page address. 

CTRL+L Align selected text to the left. 

CTRL+LEFT ARROW Go to the closest card in the previous column while working in Outlook. 

CTRL+LEFT ARROW or CTRL+RIGHT

ARROW

Move cursor's position one word to the left or right. 

CTRL+LEFT ARROW+SPACEBAR or

CTRL+RIGHT ARROW+SPACE

Select several nonadjacent items when navigating in Outlook Timeline. 

CTRL+left mouse button Edit the address of web page (URL) in a body of text. 

CTRL+M, F5 Check for new E-Mail messages. 

CTRL+N Open a New Message dialog box in order to compose and send an E-Mail. 

CTRL+P Display the Print dialog box in order to print the active selection. 

CTRL+PAGE DOWN Move cursor's position to the first card on the next page when working in Outlook. 

CTRL+PAGE UP Go to the first card on the previous page. 

CTRL+Q Mark a selected item as read in Outlook. 

CTRL+R Reply to the active E-Mail. 

CTRL+RIGHT ARROW Go to the closest card in the next column in Outlook. 

CTRL+S or Shift+F12 Save active element in Outlook.  

Visit http://www.shortcutmania.com/ for more printable keyboard shortcuts


